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1.0 Introduction 
 
This document is intended to provide a guide for utilizing the SC3-RAVTM software to 
estimate interval velocities from data acquired during Downhole Seismic Testing (DST).  
The methods of analysis covered range from basic trend line estimation to the 
recommended advanced technique, which utilizes iterative forward modeling, 
polarization analysis and signal decay.  Depending on the data collected, the basic 
analysis technique may not result in an acceptable outcome, but it will allow the user to 
make a first attempt to generate a simple velocity – depth profile (in both table and graph 
format) from the collected seismic data. 
 
The main focus of the data processing techniques outlined in this document is for data 
collected with a SH source.  However, the outlined techniques are readily applicable to 
seismic data acquired with a P-wave source.  
 
The effort required to analyze data depends to a large extent on the type and 
configuration of the wave source.  In Appendix 1 of this document the recommended 
source apparatuses and configurations are outlined for both SH-wave and P-wave 
investigations. 
 
Appendix 2 outlines the five Seismic Trace Characterization (STC) parameters which  
quantify the quality of the acquired DST data sets and act as a guide for the processing 
of those data sets to calculate interval velocities. Appendix 3 outlines a 2018 DFI 
Conference paper entitled “The use of seismic trace characterization to guide the 
analysis of DST results to obtain more accurate soil parameters”. This paper  outlines 
how the STC parameters can guide the data analysis to derive more accurate interval 
velocity results. Appendix 4 outlines a 2022 DFI Conference paper entitled “Analytically 
modelling DST arrival time databases with high order polynomials for optimal high 
resolution imaging”. This paper  outlines a new DST analysis technique which “best fits” 
a high order polynomial to arrival time data sets. 
 
It is recommended that Appendices 2, 3 and 4 are reviewed prior to proceeding with the 
training manual. It is also recommended to apply the interval velocity estimation 
methodologies outlined in Sections 4 and 5. 
 
This document is not meant to replace the manual for the SC3-RAVTM software, and we 
strongly recommend users of the software to carefully review this manual before using 
the software to analyze data. 
 
Finally, BCE staff are always available to provide guidance and assistance with the 
analysis of seismic data. 
 

 
 

Assumption: 
It is assumed that tri-axial seismic data have been collected and that the SC3-
RAVTM program is available to analyze the data. 
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2.0 Estimating Interval Velocities utilizing Vertical 
Seismic Profiles (VSPs), Dominant Responses and 
Trend Lines 

Step 2.1 – Create data folders 

 
Select SC3-RAV™ software option Utilities→SH file manipulation→without stacking. In 
the user interface dialog box navigate to the directory where the seismic data resides 
(e.g., “C:\JOBS\SCPT\SC3 Systems Training - 2020\SC3-RAV Exercise\SC3-RAV 2020 
Test Data”) and select all acquired seismic data files for a specific DST or SCPT profile.  
Next press the Open button. Note that the option with stacking will apply stacking to all 
data sets acquired at the same depth and polarity.  
 

 
 
SC3-RAV™ will then create the following subdirectories: 
 
     '...\Left Side\'; 
     '...\Right Side\'; 
     '...\Left Side\Full Waveform\' ; 
     '...\Right Side\Full Waveform\'; 
     '...\Reverse Polarity\'; 
     '...\SCPT Results\'; 
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Based upon SC*-DAC™ automatic file  naming convention1 the acquired raw seismic 
data files are moved to the appropriate '...\Left Side\'  (if ‘L’ is identified in file name) and 
'...\Right Side\' (if ‘R’  is identified in file name)  directories.   
 
If multiple “Stacked” files were acquired and saved at each depth interval it is 
recommended that user retain only the latest (higher stack count) saved trace within the 
appropriate '...\Left  Side\'   and '...\Right Side\'  directory.  This will save significant 
time in post processing.  For example, the two files SCPT408S1_0R3-6-2010 8-28-10 
and SCPT408S1_0R3-6-2010 8-29-15 are acquired at depth interval 1.0m on the right 
side.  Since SCPT408S1_0R3-6-2010 8-29-15 has a later time stamp (i.e., 8-29-15 as 
opposed to 8-28-10) it should be saved, while file SCPT408S1_0R3-6-2010 8-28-10 
should be deleted from directory '...\Right Side\'. Alternatively, the user can implement 
SC3-RAV option Utilities→SH file manipulation→with stacking. 

 

Step 2.2 – Selection of the most appropriate component 

 
Perform the following steps: 
 

• Open SC3-RAVTM. 

• Select the following menu options: View→X-Y-Z-FW Seismic Profile Display. 

• In the explorer window that then appears select a consecutive series of 10 – 15 
data files from either Folder Left or Folder Right. 

• In the Seismic Profile Parameter Specification window select that you want to 
display the x-axis and the y-axis and select different colors for the traces (see the 
manual for further details). 

• In the same window click on the Refilter Time Series button at the top of the 
window, and in the Cascadable Filters window enable the low pass filter (typically 
with a 200 Hz the low pass frequency.  Also specify Start Time if so desired, after 
which you hit the OK button. 

• In the Seismic profile parameter specification window hit the Re-display Depth 
Profile button at the top of the window. 

 
This will generate a graph with the x and y component of the seismic data (select option 
Normalize locally as shown below) and you can now select the component that is the 

 
1 A typical SC*-DAC™ automatic file name for a seismic file saved with the Automatic 

Specification check box enabled is outlined and defined as follows:   
 
SCPTS0_0R05_07_08 10-12-52 PM.aci 
 
SCPT   -  specified by the user in the Site Name edit box 
S   -  S-wave (S) or P-wave (P) - dominant source wavelet type 
0_0  - probe depth specification 
R   - right (R), left (L), or no (N) source polarization radio buttons 
05_07_08 - day data acquired (i.e., day_month_year) 
10-12-52 PM - time data acquired (i.e., hour-minute-second) 
.aci  - user specified data type 
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most dominant (i.e., “dominant response”).  The component defined as the dominant 
response is that which has predominantly greater source wave amplitudes throughout 
the depth profile.  For example, in the View→X-Y-Z-FW Seismic Profile Display plot at 
the bottom of the page the x axis has predominantly greater amplitudes compared to the 
y axis for the depth increments shown; therefore, the x axis should be defined as the 
“dominant response”. 
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Step 2.3 – Estimate VSP Trend Line Interval Velocities (Right Side) 

 
Perform the following steps: 
 

• Select the following menu options: View→Seismic Profile Display. 

• In the explorer window that then appears select a consecutive series of 10 – 15 
data files from folder Right Side. 

• In the Seismic Profile Parameter Specification window select that you want to 
display only the axis associated with the dominant responses as determined in 
Step 2.2 (see the manual for further details). 

• In the same window click on the Refilter Time Series button at the top of the 
window, and in the Cascadable Filters window enable the Low Pass Filter (with 
typical value of 200 Hz specified).  Also specify Start Time if so desired, after 
which you hit the OK button. 

• In the Seismic Profile Parameter Specification window hit the Re-display Depth 
Profile button at the top of the window.  This will generate a graph with seismic 
data for the dominant component at the various depths.  If the chart shows PPs, 
click the Display PPs button at the top of the window to remove them. 

• In the graph that is generated beginning at the top signal line, place the cursor on 
the first or second dominant peak or trough and “middle click” the mouse button.  
Repeat this operation for the reference peaks or troughs at greater depth, each 
time “middle clicking” the first or second peak or trough that occurs after the one 
that was clicked on before. 

• The graph labels that will appear give the value for the Right Side Trend Line 
Estimates at a given depth.  This graph can be used to display the simple 
velocity – depth profile graphically for the right side interval velocity trend lines.  It 
is advised that the data be copied into a table to present the data in tabular form.  
This will allow for comparisons with trend line interval velocity estimates from the 
left side of the seismic probe and reverse polarity trend line estimates. Selecting 
the Save TLEs button allows the user to save the trend line estimates to file. 
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Step 2.4 – Estimate VSP Trend Line Interval Velocities (Left Side) 

 
Perform the following steps: 
 
 

• Select the following menu options: View→Seismic Profile Display. 

• In the explorer window that then appears select a consecutive series of 10 – 15 
data files from folder Left Side. 

• In the Seismic Profile Parameter Specification window select that you want to 
display only the axis associated with the dominant responses as determined in 
Step 2.2 (see the manual for further details). 

• In the same window click on the Refilter Time Series button at the top of the 
window, and in the Cascadable Filters window enable the Low Pass Filter (with 
typical value of 200 Hz specified).  Also specify Start Time if so desired, after 
which you hit the OK button. 

• In the Seismic Profile Parameter Specification window hit the Re-display Depth 
Profile button at the top of the window.  This will generate a graph with seismic 
data for the dominant component at the various depths.  If the chart shows PPs, 
click the Display PPs button at the top of the window to remove them. 

• In the graph that is generated beginning at the top signal line, place the cursor on 
the first or second dominant peak or trough and “middle click” the mouse button.  
Repeat this operation for the reference peaks or troughs at greater depth, each 
time “middle clicking” the first or second peak or trough that occurs after the one 
that was clicked on before. 

• The graph labels that will appear give the value for the Left Side Trend Line 
Estimates at a given depth.  This graph can be used to display the simple 
velocity – depth profile graphically for the left side interval velocity trend lines.  It 
is advised that the data be copied into a table to present the data in tabular form.  
This will allow for comparisons with trend line interval velocity estimates from the 
right side of the seismic probe and reverse polarity trend line estimates. Selecting 
the Save TLEs button allows the user to save the trend line estimates to file. 
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Step 2.5 – Create Reverse Polarized Traces 

 
Perform the following steps: 
 

• Copy the files located in directories '...\Left Side\' and '...\Right Side\' into 
directory  '...\Reverse Polarity\'. 

• Select the following menu options: View→Seismic Profile Display. 

• In the explorer window that then appears select a consecutive series of 10 – 15 
data files from Folder  '...\Reverse Polarity\'. 

• In the Seismic Profile Parameter Specification window select that you want to 
display only the axis associated with the dominant responses as determined in 
Step 2.2 and select different colors for the traces from the left and those from the 
right (see the manual for further details). 

• In the same window click on the Refilter Time Series button at the top of the 
window, and in the Cascadable Filters window enable the Low Pass Filter (with 
typical value of 200 Hz specified).  Also specify Start Time if so desired, after 
which you hit the OK button. 

• In the Seismic Profile Parameter Specification window hit the Re-display Depth 
Profile button at the bottom of the window.  This will generate a graph with 
seismic data for the dominant component at the various depths.  If the chart 
shows PPs, click the Display PPs button at the top of the window to remove 
them. 

 

Step 2.6 – Estimate Reversely Polarized Trend Line Interval Velocities 

 
• In the graph generated in Step 2.5 beginning at the top pair of signal lines, place 

the cursor on the first or second cross-over and “middle click” the mouse.  
Repeat this operation for the cross-overs at greater depth, each time “middle 
clicking” the first cross-over that occurs after the one that was clicked on before. 

• The graph labels that will appear give the value for the Reversely Polarized 
Trend Line Estimates at a given depth.  This graph can be used to display the 
simple velocity – depth profile graphically, or the data can be copied into a table 
to present the data in tabular form.  Selecting the Save TLEs button allows the 
user to save the trend line estimates to file. 
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Step 2.7 – Summarize Results 

 

• Present results obtained in Steps 2.3 – 2.6 in tabular form as illustrated below. 
 

Table 1. SC3-RAVTM interval velocity estimates utilizing VSPs and trend lines 

Interval 

Depth 

(m) 

Trend Line Velocity 

Estimate (right side) 

(m/s) 

Trend Line Velocity 

Estimate (left side) 

(m/s) 

Average Trend Line 

Velocity Estimate 

(m/s) 

% 

Difference 

Reverse Polarity Velocity 

Estimate 

(m/s) 

0-5 N/A N/A N/A N/A N/A 

5-6 151.3 154.08 152.7 0.91 149.2 

6-7 216.7 206.70 211.7 2.36 221.2 

7-8 190.2 193.52 191.9 0.87 187.3 

8-9 179.3 184.74 182.0 1.49 186.3 

9-10 169.6 173.41 171.5 1.11 178.3 

10-11 180.9 180.40 180.7 0.14 170.3 

11-12 185.3 174.96 180.1 2.87 185.4 

12-13 183.8 188.24 186.0 1.19 178.5 

13-14 182.19 182.06 182.1 0.04 180.9 

14-15 178.36 185.66 182.0 2.01 194.4 

15-16 193.12 189.33 191.2 0.99 180.0 

16-17 188.28 182.92 185.6 1.44 173.7 

17-18 179.05 176.91 178.0 0.6 171.8 

18-19 152.52 165.82 159.2 4.18 185.1 

19-20 183.95 197.26 190.6 3.49 172.0 

20-21 188.91 187.63 188.3 0.34 172.1 

21-22 152.82 156.86 154.8 1.3 176.4 

22-23 205.32 178.02 191.7 7.12 185.5 

23-24 184.34 178.10 181.2 1.72 145.2 
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3.0 Estimating Interval Velocities utilizing the Cross-
correlation Technique, Batch Job Analysis, and 
Dominant Responses 

 
 

Step 3.1 – Data selection 

 
• Perform previously outlined Steps 2.1 and 2.2 to sort files and identify the 

dominant component responses  
 

Step 3.2 – Estimate Interval Velocities from Right Side 

 
Perform the following steps: 
 

• Select the following menu option: Seismic Analysis→Interval Velocity 
Calculation→Cross-correlation Method. 

• In Batch Job Analysis dialog box press button Begin Processing. 

• In the explorer window that then appears select the desired files to process from 
the folder Right Side and press button Open. 
 
 
 
 
 

 

 

 

 

 

 

 

 

 

 

• in the Cascadable Filters window enable the Low Pass Filter (with typical value of 
200 Hz specified).  Also specify Start Time if so desired, after which you hit the 
OK button. 
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• Store the cross-correlation interval velocity estimates for the component with the 
dominant responses in a data file and copy into a table to present the data in 
tabular form as shown in step 3.5 below. 

 
The Batch Job Analysis output user interface is thoroughly outlined in the SC3-
RAV™ user’s manual.  In general terms, Store Velocity Data facilitates saving 
the results to file (eg., for later Interval Velocity profiling (View->Interval Velocities 
Display) or storing in a simplified ASCII format) by putting check marks next to 
the values to be saved (all the results can be selected automatically be selecting 
the check button Select All) and selecting the Store Velocity Data drop down 
buttton. Selecting option Store Velocity Data->All axes outputs the SC3-RAV™ 
user interface for storing the estimated interval velocities formatted for displaying 
with option View->Interval Velocities Display. 
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Store Velocity Data dropdown button options X axis, Y axis, Z axis, and FW axis 
allow for the user to save interval velocity estimates of the All, X, Y, Z, or FW axis 
in a simplified format.  This option is provided so that output can be generated, 
which can be easily incorporated into a Word® table or Excel® spread sheet.  
The user simply selects the appropriate axis to store and then user interface is 
provided for specification of the single axis velocity filename  In this interface the 
FW axis refers to the estimated interval velocities, which were calculated based 

upon the absolute amplitude . This is not the 

same as the full waveform obtained from Polarization Analysis and mapped to 
the X axis. 
 

Step 3.3 – Estimate Interval Velocities from Left Side 

 
• Perform the same action items outlined in Step 3.2, but now with files selected 

from the folder Left Side. 

 

Step 3.4 – Estimate Interval Velocities Utilizing LLSR 

 

• The SC3-RAVTM program also allows the user to perform this analysis while 
applying at the same time a Linear Least Square Regression (LLSR).  Using this 
option results in smoothing highly variable adjacent interval velocities (please see 
SC3-RAVTM user’s manual for more detail). 

 
To activate this option the user should check the Enable Linear Least Squares 
Regression within the Batch Job Analysis dialog box and input the reference 
depth (5 m) and arrival time (54 ms) as outlined in Section 4.4., after which the 
procedure described in either step 3.2 or 3.3 can be followed. 
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Step 3.5 – Summarize Results 

 
• Present results obtained in Steps 3.2 – 3.4 in tabular form as illustrated below. 

 

Table 2. SC3-RAVTM Interval velocity estimates (Cross-correlation Technique LLSR) 

Interval 

Depth 

(m) 

CCT 

Right Side 

(m/s) 

CCT 

 Left Side 

(m/s) 

Average  

CCT 

(m/s) 

% 

Difference 

LLSR 

Right Side 

(m/s) 

LLSR  

Left Side 

 (m/s) 

Average 

LLSR 

(m/s) 

% 

Difference 

0-5 N/A N/A N/A N/A N/A N/A N/A N/A 

5-6 146.450 147.180 146.8 0.25 171.030 172.430 171.7 0.41 

6-7 208.770 211.670 210.2 0.69 171.030 172.430 171.7 0.41 

7-8 173.050 182.850 178.0 2.75 180.080 182.960 181.5 0.79 

8-9 187.760 183.060 185.4 1.27 180.080 182.960 181.5 0.79 

9-10 173.310 171.460 172.4 0.54 172.130 175.080 173.6 0.85 

10-11 170.970 178.870 174.9 2.26 172.130 175.080 173.6 0.85 

11-12 189.030 175.400 182.2 3.74 188.180 181.140 184.7 1.91 

12-13 187.360 187.360 187.4 0 188.180 181.140 184.7 1.91 

13-14 177.180 178.150 177.8 0.27 177.760 181.850 179.8 1.14 

14-15 178.350 185.750 182.1 2.03 177.760 181.850 179.8 1.14 

15-16 190.880 192.370 191.6 0.39 185.110 185.970 185.5 0.23 

16-17 179.790 180.120 180.0 0.09 185.110 185.970 185.5 0.23 

17-18 170.770 174.080 172.4 0.96 170.450 170.580 170.5 0.04 

18-19 170.140 167.270 168.7 0.85 170.450 170.580 170.5 0.04 

19-20 183.900 197.430 190.7 3.55 181.130 188.410 184.8 1.97 

20-21 178.480 180.420 179.5 0.54 181.130 188.410 184.8 1.97 

21-22 171.850 166.950 169.4 1.45 177.680 169.130 173.4 2.47 

22-23 184.060 171.390 177.7 3.56 177.680 169.130 173.4 2.47 

23-24 195.380 171.210 183.3 6.59 195.380 171.210 183.3 6.59 
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4.0 Estimating Interval Velocities utilizing Batch 
Polarization Analysis, Batch Signal Decay and Iterative 
Forward Modeling (Advanced Technique) 
 
To make full use of the recorded triaxial data, the data acquired on the x, y and z axis is 
rotated onto the full waveform axis utilizing batch Polarization Analysis (PA), which 
dramatically increases the signal-to-noise ratio. In addition, PA allows the investigator to 
apply BCE’s proprietary Seismic Trace Characterization (STC) technique (see Appendix 
2). By applying Source Wave Signature Isolation (SWSI) as well any outliers from the 
peak source wave responses are removed so that possible reflections and systematic 
noise is minimized.  
 
The ability to dramatically increase the probability of identifying and quantifying critical 
layers utilizing SCPT can be achieved by applying larger than normal sensor-source 
radial offsets and implementing analysis techniques which incorporate Fermat’s principle 
such as the FMSDM provided within SC3-RAVTM.  By doing this the source wave can 
refract and travel within critical layers for an extended time, dramatically increasing 
characterization of the layer or depth under analysis.  In addition, larger than normal 
offsets allows for greater SCPT vertical resolution because small depth increments are 
feasible. 
 

Step 4.1 – Sort Data 

 
• Perform previously outlined Steps 2.1 and 2.2 to sort files and identify the 

dominant component responses  
 

Step 4.2 – Implement batch Polarization Analysis (PA) 

 

• Implement SC3-
RAV™ software 
option Seismic 
Analysis→ 
Polarization Analysis 
and Seismic Trace 
Classification→Batch 
Processing on data 
moved to directories  
'...\Right Side\'  and  
'...\Left Side\'  . This 
option allows for the rotation of the SH source wave responses onto the Full 
Waveform Axis (FWA).  Once the software option is selected a dialog box 
appears, which allows the user to define a specific Reference Axis (dominant 



 
 

SC3-RAV Data Analysis ©Baziw Consulting Engineers Ltd. 16 

 COMMERCIALLY CONFIDENTIAL 

 

source wave responses). Specify a text data file to store the estimated STCs 
(e.g., ‘RS STC.txt’) and specify the Analysis Type (i.e., SH Wave or P/SV Wave). 
The estimated STCs should be presented in Tabular form. 
 
A typical STCs output file is illustrated below: 
 

Depth LIN SSP CCC PSD SNR STC 

[m] [0-1] [0-1] [0-1] [0-1] [0-1] [A-F] 

       

5 0.6184 0.63 0 0.87 0.93 N/A 

6 0.8386 0.691 0.9221 0.93 0.98 D 

7 0.8111 0.642 0.9528 0.93 0.98 B 

8 0.776 0.612 0.9688 0.83 0.98 B 

9 0.8193 0.57 0.9761 0.85 0.98 B 

10 0.8512 0.615 0.984 0.81 0.98 B 

11 0.8332 0.641 0.9905 0.9 0.98 A 

12 0.8542 0.612 0.9946 0.91 0.98 A 

13 0.8865 0.61 0.9904 0.85 0.98 A 

14 0.8577 0.604 0.9934 0.83 0.98 A 

15 0.8578 0.595 0.9895 0.9 0.98 B 

16 0.8612 0.65 0.9822 0.92 0.98 A 

17 0.8544 0.653 0.986 0.93 0.98 A 

18 0.8171 0.672 0.9931 0.93 0.98 A 

19 0.8263 0.624 0.9935 0.93 0.98 B 

20 0.8522 0.618 0.9826 0.93 0.98 B 

21 0.8099 0.557 0.9772 0.93 0.98 D 

22 0.8941 0.507 0.9775 0.93 0.98 D 

23 0.8248 0.577 0.9787 0.93 0.98 D 

24 0.8386 0.488 0.9375 0.93 0.98 D 
SSP Values which drop below the 0.57 threshold value will automatically result in STC ‘D’ values. 

This is a flag that the traces may require time windowing via option Seismic Analysis→ Source 

Wave Signature Isolation.   

 
Next the user select the Select Data Files button, which allows the user to select 
the files to have full waveform conversion applied.  Once the files for full 
waveform conversion have been selected press button Begin Processing.  The 
Cascadable Filters dialog box appears so that the user can specify desired filters.   
Once the files are converted they are stored in directories '...\Left Side\Full 
Waveform\'  or '...\Right Side\Full Waveform\'.  The files are renamed with 
extension ‘_FW’ appended to the file name.  For example, file SCPT408S1_0R3-
6-2010 8-29-15.aci is renamed to SCPT408S1_0R3-6-2010 8-29-15_FW.aci.   
 
The SH full waveforms are stored on the X axis on the rotated trace (i.e., only the 
X axis (FWA) for file SCPT408S1_0R3-6-2010 8-29-15_FW.aci should be 
analyzed).  The results of the file rotation is evident by analyzing the trace 
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utilizing SC3-RAV™ software option View→ Display X-Y-Z-Full Waveform VSP 
with option Normalize Locally enabled.  Compared to the “Before” the amplitudes 
of the Y axis trace will be much smaller in the “After” as the full wave form 
displayed on the X axis in the “After” is much stronger than the original X axis 
wave as illustrated below.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
View→ Display X-Y-Z-Full Waveform VSP with option Normalize Locally 
enabled displaying vertical seismic profile “before” batch polarization 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
View→ Display X-Y-Z-Full Waveform VSP  with option Normalize Locally 
enabled displaying vertical seismic profile “after” batch polarization 
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Only FWA traces should be used if the associated LIN ≥ 0.8. For the RS data set 
traces recorded at 5m and 8m have LIN values < 0.8. In this case the X Axis 
responses will be required at these depths when estimating interval velocities. 
The user should verify that the LIN values are for the seismic source wave 
responses and not from relatively higher amplitude measurent noise. This is 
readily done by plotting both the FWA traces and associated X/Y original traces 
within View→ Display X-Y-Z-Full Waveform. This is shown below. 
 

 
 
 
The investigator can readily process mixed 
FWA (LIN ≥ 0.8) and dominant X axis (LIN 
< 0.8) responses for a specific profile and 
RS/LS polarity by simply copyng the 
relevant files to a working directory (e.g., 
copy original X axis traces from depths 5m 
and 8m to directory directories  '...\Right 
Side\Full Waveform\').  
When utilizing mixed FWA (LIN ≥ 0.8)  and dominant Y axis (LIN < 0.8) traces for 
a specific profile and RS/LS polarity it is first necessary to map the Y Axis 
responses onto the FWA. In this process Utilities→Full waveform components 
should be selected and X Axis and Z Axis boxes unchecked. Next implemenet 
Seismic Analysis→ Polarization Analysis and Seismic Trace 
Classification→Batch Processing where the Y Axis is selected as the reference 
axis and Save STC Values is unchecked. Next Specify Data Files for the Y Axis 
traces to be rotated onto the FWA and select Begin Processing. After rotation of 
the desired Y Axis responses onto the FWA it is necessary that the user recheck 
the X Axis and  Z Axis check boxes in  Utilities→Full waveform components 
interface.  
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Step 4.3 – Implement Source Wave Signature Isolation 

 

• Implement SC3-RAV™ software option Seismic Analysis→Source Wave Feature 
Isolation (SWFI) on FWA data located in directories  '...\Right Side\Full 
Waveform\'  and  '...\Left Side\Full Waveform\'.  This option allows for further 
Signal-to-Noise Ratio (SNR) improvement by removing responses due to 
possible source wave reflections or “unclean” SH source hammer impacts. In 
general terms, it allows isolation of trending source wave features (i.e, peak or 
trough). SWFI  software option Batch analysis type without Enable user defined 
feature checked determines the time index, t*, which is the location of the 
absolute maximum amplitude of the seismic trace under analysis.  An 
exponential decay is then applied at the second zero crossing from t* for both the 
front end and back end of the trace. Please see SC3-RAV user’s manual and 
Appendix 3 for further details of the SWFI software options.  

Upon selecting 
software option SWFI 
the user interface 
illustrated to the left  
appears.  The Decay 
Factor is defaulted to 
4.0.  As the Decay 
Factor is increased 
there is a sharper 
decay of the time 
series.  User interface 
Reference Axis allows 
for the specification of 
the reference axis (X 
Axis, Y Axis, Z axis, 
and FW Axis), from 
which the time index, 
t*, location of the absolute maximum amplitude of the seismic trace under 
analysis is determined. In addition, the user specified  Reference Axis instructs 
the algorithm which axis SWFI should be applied to.   
The user presses button Select Data Files and selects the files to have signal 
decay applied (from directories '...\Left Side\Full Waveform\' and '...\Right 
Side\FullWaveform\').  The files which have had the SWFI standard Batch 
analysis type are stored in directories '...\Left Side\Full Waveform\FIB\' and 
'...\Right Side\Full Waveform\FIB\'.  The files are renamed with extension ‘_GSD’ 
appended to the file name.  For example, file SCPT408S1_0R3-6-2010_8-29-
15_FW.aci is renamed to SCPT408S1_0R3-6-2010_8-29-15_FW_GSD.aci.  
When processing the Full Waveform data a specification of a Cascadable Filter is 
not required because a filter has already been applied during the batch PA 
process.  In addition, the Reference Axis should be specified as the X Axis. 
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The figure below illustrates the VSP output after applying software option FW 
SWFI standard Batch analysis type.  As is evident, the seismic SH source wave 
pulse (trending peak) has been isolated. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The figures below shows the application of Start Time within software option 
Seismic Analysis→ Source Wave Signature Isolation→ Standard Batch analysis 
type.  In the figure on the left a VSP is displayed where there is a strong seismic 
response (within 20 ms) prior to the arrival of the desired SH wave (starting at 
approximately 60 ms at depth 12m.  The figure on the right shows the VSP after 
the application of Start Time = 60 ms. 
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Step 4.4 – Estimate Reference Arrival Time 

 
Perform the following steps: 
 

• Select the following menu options: View→Seismic Profile Display or View→X-Y-
Z-FW Seismic Profile Display. 

• In the explorer window that then appears select a consecutive series of the 
shallowest 1 – 5 data files from folder '...\Reverse Polarity\' where the Right Side 
and Left Side traces have been copied to. A reference trace is utilized were a 
“clean” source wave is present. It should be noted that near surface source 
waves are significantly more susceptible to refraction which contaminates the 
recorded seismogram; therefore, the first “clean” near surface trace with minimal 
evidence of refraction is utilized. In the Cascadable Filters window a relatively 
higher low pass frequency (e.g., 400Hz or greater) is specified so that the signal 
definition at first break is retained. Select the reference trace at a depth (starting 
at near surface) where a clear arrival is present. 

• In the Seismic Profile Parameter Specification window select that you want to 
display only the axis associated with the dominant component and select 
different colors for the traces from the left and those from the right (see the 
manual for further details). 

• In the same window click on the Refilter Time Series button  at the top of the 
window, and in the Cascadable Filters window do not enable any of the digital 
filters.  Hit the OK button. 

• In the Depth Profile Parameter Specification window hit the Re-display Depth 

Profile button  at the top of the window.  This will generate a graph with 
seismic data for the dominant component at the various depths.  If the chart 
shows PPs, click the Display PPs button at the top of the window to remove 
them. 

• From the unfiltered VSP plot, identify seismic waves from a specific depth, Arrival 
Depth, which have source waves with the highest signal to noise ratio (e.g., 
seismic waves at depth 5m in VSP plot illustrated below (note that this DST 
started at a depth of 5 m). 
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• In the same window click on the Refilter Time Series button at the top of the 
window, and in the Cascadable Filters window enable the Low Pass Filter 
(typically with a cut-off frequency of 400 to 500 Hz).  Also specify Start Time if so 
desired, after which you hit the OK button. 

• In the Depth Profile Parameter Specification window hit the Re-display Depth 
Profile button at the top of the window.  

• In the filtered VSP plot, zoom-in on the seismic traces at the Arrival Depth by 
clicking the left mouse button while scrolling in with the mouse.  Quantify the first 
break arrival time by placing the cross-hairs at the first break (e.g., 55ms at 5m 
for VSP plot shown below).  Make note of Arrival Depth and corresponding 
Arrival Time. 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Step 4.5 – Estimate Arrival Times and Enter Data into the Database 

 

• Implement SC3-RAV™ software option Seismic Analysis→Interval 
Velocities→Crosscorrelation Technique on FWA signal decayed data located in 
directories  '...\Right Side\Full Waveform\GSD\'  and  '...\Left Side\Full 
Waveform\GSD\' so that source wave arrival times can be determined. The 
arrival times are utilized within the FMDSM technique. 
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As illustrated above and outlined in the SC3-RAV™ user’s manual, fundamental 
inputs for the FMDSM technique are the referenced arrival time and the 
corresponding depth.  The reference depth (5m) and arrival time (55ms) values 
are inputted in the Batch Job Analysis interface.  The reference depth and time 
for both the ‘Right Side’ and Left Side’ should be fairly close in value.  Option 
Display and Calculate Arrival Times is also checked.  
 
In the Batch Job Analysis panel select button Begin Processing.  Once the 
Begin Processing button is selected the file input dialog box user interface 
appears, where the user selects the files to have arrival times calculated from 
either the  '...\Right Side\Full Waveform\GSD\'  directory or  '...\Left Side\Full 
Waveform\GSD\' depending upon the reference depth and time.  
 
The Batch Job Analysis output is illustrated below for the processed filtered 
traces residing in directory '...\Right Side\Full Waveform\GSD\'.  In the top box 
the estimated interval velocities are listed (using a BCE patented crosscorrelation 
technique) whereby a straight ray trajectory is assumed.  Again only the FWA X 
axis results are of interest.  The bottom list box displays the estimated arrival 
times based upon the user specified reference depth and arrival time and 
crosscorrelation calculated relative arrival times. 
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The ability to export the estimated arrival times to the FMDSM database provides 
significant post processing time saving.  The SC3-RAV™ software extracts the 
site name from a SC*-DAC™ file based upon the automatic file naming 
convention as previoulsy outlined.  The extracted Site Name is placed within text 
box Site Name.  The user can readily modify or change the Site Name.  In the 
above example, the Site Name has RS appended to the site name to denote the 

right side estimates. Button  facilitates exporting estimated arrival times to the 
FMDSM database.  In the automated SH wave high-spec batch job analysis the 
user first processes the data set on the '...\Right Side\Full Waveform\GSD\'  

directory.  Option Overwrite Record is selected (default setting) and button  is 
pressed (with FWA (X axis) selected for export).  The corresponding X axis 
arrival times are then copied to the FMDSM database with measurement weights 
set 1.  Note that user interface radio button options X Axis, Y Axis, Z Axis and All 
Axes allow for copying the X Axis, Y Axis, Z Axis and absolute amplitude 

 Axis arrival times, respectively, to the FMSDM 

database.  
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Next the estimated X axis arival times from the dataset located under directory 
'...\Right Side\Full Waveform\GSD\' are exported to the FMDSM database with 
option Overwrite Record selected and RS appended to the site name. This will 
allow for the right side and left side interval velocities to be compared. An 
example FMDSM database with the above process implemented is illustrated 
below.  

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Implement SC3-RAV™ software option Seismic Analysis→Interval 
Velocities→FMDSM on the previously saved arrival times from datasets located 
under directories directories '...\Right Side\Full Waveform\GSD\' and '...\Left 
Side\Full Waveform\GSD\'. The user specifies the source Radial Offset, source 
Depth offset within the FMDSM graphical user interface.  Next the user selects 

the FMDSM Database button  so that the appropriate database can be 
selected from the FMDSM database as outlined in the SC3-RAV™ user’s 
manual.  In the above example database SCPT 2020 TestData_RS has been 
selected. The user then presses button Begin Processing. The figure below 
illustrates the FMDSM output, which graphically shows the estimated interval 
velocities and corresponding ray tracing of the travel path of the source waves to 
the downhole seismic sensors.  
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Reselecting the FMDSM Database button  will result in the reopening of the 
FMDSM database with the estimated interval velocities displayed as shown 
below.  The results given below are tabulated and submitted to the client along 
with the right side results.  
 

 
 
 
 



 
 

SC3-RAV Data Analysis ©Baziw Consulting Engineers Ltd. 27 

 COMMERCIALLY CONFIDENTIAL 

 

 
 

The light green background below is a visual indicator that FMDSM estimated RS and 

LS interval velocities have percent differences < 10% and are highly reliable.  

 

Table 3. SC3-RAVTM FMDSM interval velocity estimates  

Interval 

Depth 

(m) 

FMDSM 

Right Side 

(m/s) 

FMDSM 

 Left Side 

(m/s) 

Average  

FMDSM 

(m/s) 

% 

Difference 

0-5 100.1 100.1 100.1 2.34 

5-6 135.4 141.9 138.7 1.57 

6-7 197.9 191.8 194.9 1.42 

7-8 182 176.9 179.5 0.33 

8-9 178.9 180.1 179.5 1.02 

9-10 173.7 170.2 172 3.51 

10-11 166.4 178.5 172.5 3.32 

11-12 188.5 176.4 182.5 0.27 

12-13 187.1 186.1 186.6 0.79 

13-14 175.9 178.7 177.3 2.49 

14-15 175.9 184.9 180.4 0.74 

15-16 188.2 191 189.6 0.72 

16-17 182 179.4 180.7 0.61 

17-18 171.2 173.3 172.3 0.68 

18-19 170.1 167.8 169 3.99 

19-20 183 198.2 190.6 0.06 

20-21 177.5 177.7 177.6 0.24 

21-22 168.7 167.9 168.3 2.83 

22-23 181.5 171.5 176.5 2.92 

23-24 185.1 174.6 179.9 2.34 
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5.0 Fitting Higher Order Polynomials to DST Arrival Time 
Data Sets for High Resolution Imaging 
 
The DST arrival times have associated measurements errors and resolution limitations 
which become more pronounced as the depth interval of analysis is reduced. 
Transducer based triggers (e.g., geophone) as opposed to “contact” based triggers can 
also result in increased measurements errors. The errors in arrival time measurements 
can result in extensive fluctuations in the estimated interval velocities with numerous 
outliers. BCE has developed a new DST analysis technique, the so-called DSTPolyKF 
algorithm, where analytically modelling of the DST arrival time data sets is accomplished 
by fitting high order polynomials. The main advantages of this new technique are five-
fold. 1) Ability to utilize all arrival time estimates irrespective of measurement errors. 2) 
Ability to process small depth interval (≤ 0.5m) arrival time data sets. 3) Analytical 
polynomial “best fit” function allows for user specification of desired depth intervals for 
data interpolation. 4) Facilitates sophisticated data fusion for significantly more accurate 
DST interval velocity estimation. 5) Polynomial regression accuracy parameters quantify 
how well the “best fit” polynomial fits the acquired arrival time data sets.  
 
Appendix 4 of this document outlines the mathematical details of the DST arrival time 
best fit polynomial algorithm. It has found that this technique has worked exceptionally 
well when processing DST acquired from offshore investigations. Offshore DST 
investigations typically have numerous data sets available at each depth increment (right 
side and left side top and bottom seismic sensors offset by from 0.5m to 1.0m). In 
addition geophone triggers are utilized.  
 
There are four parameters which are utilized to evaluate the accuracy of the polynomial 
regression best fit. These four parameters are mean squared error (MSE) of the 
polynomial estimator, Mean Absolute Percentage Error (MAPE), coefficient of 
determination (R2), and adjusted coefficient of determination (R*2). Appendix 4 outlines 
the four polynomial regression accuracy parameters by their mathematical 
representations and important characteristics. It is recommended that polynomial 
regressions of order 2 to 7 are derived for the estimated DST source wave arrival times. 
The polynomial aggression order  which results in the “best” accuracy parameter values 
as defined in Appendix 4 and lowest polynomial order is utilized. This approach 
addresses the well-known bias-variance tradeoff of polynomial regression. 
 
 
 
 
 
 
 
 
 
 
 



 
 

SC3-RAV Data Analysis ©Baziw Consulting Engineers Ltd. 29 

 COMMERCIALLY CONFIDENTIAL 

 

 

Step 5.1 – Identify the DST Arrival Times from Data Set Available 

 
The Figure below illustrates the estimated TSLS (Top Sensor Left Side), TSRS 
(Top Sensor Right Side), BSLS (Bottom Sensor LS) and BSRS (Bottom Sensor 
RS) estimated arrival times for the offshore DST data set. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Step 5.2 – Calculate Average Arrival Times, Calculate the Associated 
Four Polynomial Parameters and Select the Order of the Polynomial 
and Calculate Polynomial Best fit 

 
 
 
 

 Polynomial 

Order 

RMS MAPE   

2 4.8413 4.2236 0.998327 0.998264 

3 2.4921 1.9924 0.999565 0.99954 

4 1.2825 1.0099 0.999887 0.999878 

5 1.0571 0.7638 0.999925 0.999917 

6 1.0357 0.6924 0.999929 0.999921 

7 0.9672 0.6404 0.99994 0.999931 

Table 4. Estimated polynomial accuracy parameters for averaged 

arrival times obtain from arrival times illustrated above 
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Table 4 outlines the corresponding polynomial regression estimated accuracy 
parameters for the averaged arrival times (TSLS, TSRS, BSLS, and BSRS) illustrated in 
the figure above and orders 2 to 7. From the results outlined in Table 4, the 6th and 7th 
order polynomial aggressions have overall “best” accuracy parameter values as defined 
in Table 4. Although, the 5th order polynomial regression result are also very close to  6th 
and the 7th order polynomial results. The figure below illustrates the averaged TSLS, 
TSRS, BSLS and BSRS arrivals times with the 7th order polynomial regression best fit 
line. It is recommended that both 6th and 7th order polynomial regression best fit 
estimates are obtained and resulting interval velocities compared. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Averaged arrival times (red dots) and 7th order polynomial regression best fit 
(blue line) for the offshore real DST analysis. 
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Step 5.3 – Specify the Depth Resolution of Best Fit Polynomial, 
Generate Associated Arrival Times and Import Best Fit Polynomial 
Arrival Times into the FMDSM Database 
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Step 5.4 – Implement FMDSM Algorithm on Imported Best Fit 
Polynomial Arrival Times and Tabulate and Plot Interval Velocities 
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Depth 

[m] 

6th Order 

Interval 

Velocity 

[m/s] 

7th Order 

Interval 

Velocity 

[m/s] 

6th and 7th 

Order 

Precent 

difference 
    

1.24 89.7 89.7 0 

1.74 98.3 99.6 0.7 

2.24 105.9 108 1 

2.74 114.2 116.5 1 

3.24 123.1 125 0.8 

3.74 132.3 133.1 0.3 

4.24 141.2 140.6 0.2 

4.74 149.6 147.3 0.8 

5.24 157.1 153.3 1.2 

5.74 163.7 158.7 1.6 

6.24 169.1 163.4 1.7 

6.74 173.5 167.8 1.7 

7.24 177 171.7 1.5 

7.74 179.8 175.4 1.2 

8.24 181.9 178.8 0.9 

8.74 183.6 181.9 0.5 

9.24 185 184.8 0.1 

9.74 186.2 187.6 0.4 

10.24 187.4 190.1 0.7 

10.74 188.5 192.4 1 

11.24 189.7 194.6 1.3 

11.74 190.9 196.6 1.5 

12.24 192.2 198.4 1.6 

12.74 193.7 200 1.6 

13.24 195.3 201.4 1.5 

13.74 196.9 202.7 1.5 

14.24 198.7 203.8 1.3 

14.74 200.6 204.9 1.1 

15.24 202.5 205.8 0.8 

15.74 204.6 206.7 0.5 

16.24 206.7 207.6 0.2 

16.74 208.8 208.4 0.1 

17.24 211 209.3 0.4 

17.74 213.3 210.3 0.7 

18.24 215.5 211.4 1 

18.74 217.8 212.6 1.2 

19.24 220.1 214 1.4 

19.74 222.3 215.5 1.6 

20.24 224.6 217.2 1.7 

20.74 226.8 219.2 1.7 

21.24 229.1 221.4 1.7 

21.74 231.3 223.8 1.6 

22.24 233.5 226.5 1.5 

22.74 235.6 229.4 1.3 

23.24 237.8 232.6 1.1 

23.74 239.9 236 0.8 

24.24 242 239.7 0.5 

Table 5. Estimated interval velocities and percent 

differences for polynomial regressions of orders  6 and 

7. 
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24.74 244.1 243.5 0.1 

25.24 246.2 247.4 0.2 

25.74 248.3 251.5 0.6 

26.24 250.5 255.7 1 

26.74 252.6 259.8 1.4 

27.24 254.8 263.8 1.7 

27.74 257 267.7 2 

28.24 259.2 271.2 2.3 

28.74 261.5 274.5 2.4 

29.24 263.8 277.2 2.5 

29.74 266.1 279.5 2.5 

30.24 268.5 281.1 2.3 

30.74 270.9 282.1 2 

31.24 273.4 282.4 1.6 

31.74 275.9 282.1 1.1 

32.24 278.3 281.1 0.5 

32.74 280.7 279.7 0.2 

33.24 283.1 277.8 0.9 

33.74 285.4 275.6 1.7 

34.24 287.5 273.4 2.5 

34.74 289.4 271.3 3.2 

35.24 291.1 269.6 3.8 

35.74 292.4 268.6 4.2 

36.24 293.3 268.6 4.4 

36.74 293.8 270.1 4.2 

37.24 293.7 273.6 3.5 

37.74 292.9 279.8 2.3 

38.24 291.3 289.9 0.2 

38.74 289 305.5 2.8 

39.24 285.7 329.7 7.1 

39.74 281.4 368 13.3 
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Appendix 1 - Recommended source apparatuses and 
configurations for a SH-wave and P-wave investigations. 
 
It very important in DST that proper SH-source and P-wave sources are utilized. The 
BCE recommended source design and set-up configuration are outlined below. 
 

SH-Source design and configuration 

 
1. Apply Right and Left polarized “point” SH source plates with specially designed ribs.  
Point sources should be utilized so that the source location (x, y, and z coordinates) can 
be quantified accurately for subsequent interval velocity calculation.  For example, if a 
large SH-hammer beam is utilized, it becomes difficult to specify the exact location of the 
seismic source.  Moreover with a point source the concern of proper coupling between 
the beam and the soil underneath along the entire length of the beam is mitigated. 
 
2. Use an aluminum strike plate for the source plates to reduce the “pinging” noise when 
they are struck with a heavy sledge hammer. 
 
3. Use a “Contact” trigger with a strike plate which acts an electrical switch trigger (i.e., 
trigger occurs when hammer makes contact with the strike plate).  The set-up offers an 
excellent “Contact” type trigger as illustrated in the figure below.  
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4. Apply relative large sensor-source radial offsets (SSROs) and in case of SCPT, 
decouple the SH source from the test rig.  Large SSROs decrease near field amplitudes 
considerably, resulting in significantly higher signal-to-noise ratios of the recorded 
seismic data, which in turn allows for more accurate near surface stratigraphy 
characterization.  In addition, in case of SCPT this approach results in minimal recording 
of “rod” noise. Finally, large SSROs increase the characterization of the layer or depth 
under analysis due to the fact that the source wave refracts and travels within 
stratigraphic layers for a longer period of time 
 
5. Load SH source plates so that slip between plates and the soil underneath does not 
occur, while at the same time the lateral displacement upon hammer impact is restricted 
as little as possible.  It has been found that a good way to achieve this is to have vehicle 
air filled rubber wheels loaded upon the SH source plates. 
 

P-Source design and configuration 

 
In general terms, a P-wave source requires symmetric (with respect to volume change) 
displacement such as an explosive source detonated within the medium near the 
surface.  Some acceptable P-wave source consists of buffalo guns (i.e., 12 gauge shot 
gun shell fired in the ground), air guns, electrical sparker system and vertical hammer 
impact which results in a symmetric displacement of a membrane placed within the 
medium near surface.  The previously described P-wave source will typically also 
generate SV waves, which are subsequently recorded by the downhole seismic sensors.  
A typical SV wave source configuration consists of lowering a shear type source within a 
borehole and then clamping the SV wave source against the side of the borehole (using 
a pneumatic or mechanical clamp).  The SV wave type source then facilitates the 
investigator applying a vertical shearing impact to the side of the borehole so that a 
predominantly SV source wave is generated.  Some investigators apply a vertical impact 
on the ground surface to generate a P-wave source.  The major disadvantages of 
utilizing this type of mechanism are two-fold: 
 
1. Only one-third of the energy generated by a vertical source on a uniform half-space is 
transformed into body waves (compression and shear), while the other two-thirds of the 
energy generated is transformed into surface waves. 
 
2. Body waves at the surface have lower amplitudes than body waves in the half-space. 
 
Contact type triggers should be used with the P-wave source. These types of triggers 
can readily be incorporated into the P-wave source. 
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Appendix 2 - Seismic Trace Characterization Parameters 
 
Introduction 
 
BCE has invested considerable resources into the development of techniques and 
algorithms to characterize acquired Downhole Seismic Testing (DST) data sets for shear 
wave velocity assessment, and to use that characterization as a guide for the processing 
of those data sets to calculate interval velocities. 
 
The characterization is based on various independent parameters of the acquired DST 
data at a particular depth.  Currently five parameters are considered: 
 

• Parameter 1: the linearity estimates (LIN) from polarization analysis.  The LIN 
trace metric quantifies the correlation between X, Y and Z axis responses.  

• Parameter 2: the Cross Correlation Coefficient (CCC) of the full waveforms at the 
particular depth and the preceding depth.  The CCC trace metric gives an 
indication of the similarity between the two waves being correlated when deriving 
relative arrival times. 

• Parameter 3: the Signal Shape Parameter (SSP).  The SSP trace metric 
quantifies the deviation of the shape of the frequency spectrum from an ideal bell 
shape 

• Parameter 4: the Peak Symmetry Differential (PSD) trace metric facilitates the 
identification of traces whose peak source wave responses have been 
significantly skewed due to measurement noise or source wave reflection 
interference.  

• Parameter 5:  Signal to Noise Ratio (SNR).  The SNR trace metric is solely 
provided to quantify what portion of the spectral content of the recorded 
seismogram resides within the desired source frequency spectrum irrespective of 
source wave distortions such as near-field effects, reflections, refractions, and 
“dirty sources”. 

 
For these five parameters the part of the data sets that will be used and filtered is shown 
in the table below: 
 

Parameter Part of trace that is reviewed Applied Signal 
Filtering 

LIN Largest peak/trough ± 30 ms 200 Hz low pass 

CCC Largest peak/trough -30ms for upper 
trace 

Largest peak/trough +30ms for lower 
trace 

200 Hz low pass 

SSP Entire trace 200 Hz low pass 

PSD Largest peak/trough ± 2 crossovers 200 Hz low pass 

SNR Largest peak/trough ± 2 crossovers None / 200 Hz low 
pass 
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This Technical Note introduces the parameters, while Technical Note 21 provides a 
guide for the recommend post data processing and seismic signal processing based 
upon these parameters. 
 
It should be noted that the characterization process may be updated as more data set 
are reviewed. 
 
Parameter 1: LIN 
 
The linearity or rectilinearity values can be obtained from hodograms, i.e. by plotting the 
X, Y and Z axis amplitudes against one another and fitting least squares best fit lines.  
Since hodograms with linearity values nearing 1.0 identify seismic recordings that have 
highly correlated responses on the X, Y and Z axes and strong directionality, the interval 
velocities calculated from such recordings are likely to be accurate.  Hodograms with 
lower linearity values on the other hand indicate lower signal-to-noise ratios or SNRs 
(whether due to poor source generation, near-field waves, ambient noise that is not 
easily filtered out or source wave reflections) and thus the resulting interval velocity 
values are likely to be less accurate. 
 
To provide for a more accurate quality assessment of the recorded data minimal digital 
frequency filtering should be applied to the raw data, while more refined and aggressive 
digital frequency can be applied during the actual data analysis to determine the interval 
velocities.   
 
The X, Y and Z responses in Figure 1 below from a SH source (after applying a low pass 
frequency filter of 200 Hz) have clearly high SNRs values: the peaks and troughs on the 
X and Y axis line up, and there are minimal recordings on the Z axis as would be 
expected for this kind of source.    
 

 

Figure 1: Correlated triaxial responses resulting in high linearity values. The 
source wave X and Y axis peaks and troughs are aligned 
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The hodogram plot for this triaxial recording is shown in Figure 2 below.  In this 
hodogram the amplitudes of the X and Y axes recordings (dominant energy for a SH 
source) are plotted as green circles and the red line is the best fit straight line (with a 
calculated linearity of 0.92).  This clearly reflects a good quality seismic source recording 
with a high correlation between the X and Y axis and high directionality along an axis 
with an azimuth of approximately 13º. 

 

Figure 2: The hodogram plot for the triaxial responses illustrated in Fig. 1. The 
hodogram  clearly reflects a good quality seismic source recording with a high 
correlation between the X and Y axis and high directionality along an axis with an 
azimuth of approximately 13º. 

 
In the triaxial seismic trace recording in Figure 3 the peaks and troughs on the X, Y and 
Z do not line-up and the background noise (whether due to a poor source, vibrations 
within the testing vehicle upon impact of the SH wave sledge hammer and/or other 
causes) has frequency components similar to the source wave making the isolation of 
the source wave with frequency filters a challenging tasks. 
 

 

Figure 3: Poorly correlated triaxial responses resulting in low linearity values. The 
source wave X and Y axis peaks and troughs are not aligned. 

The hodogram plot for this recording is shown in Figure 4 below.  The amplitudes of the 
X and Y axes recordings are plotted (green circles) and the red line is again the best fit 
straight line, but obviously with a much lower calculated linearity than in the first example 
(0.61 vs. 0.92).  
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Figure 4: The hodogram plot for the triaxial responses illustrated in Fig. 3. The 
hodogram  clearly reflects a poor quality seismic source recording with a low 
correlation between the X and Y axis and low directionality. 

 
Parameter 2: CCC 
 

The cross-correlation between two time or distance offset seismograms is given as 
(Gelb 1974) 

 
 

(1) 

 

where  is the cross-correlation function,  the sampled data at distance 1 and at 

sample time k,  the sampled data at distance 2 at sample time k, and  the time shift 

between the two sets of recorded waves (note: distance 2 > distance 1).  The value of 
the time shift at the maximum cross-correlation value is assumed to be the relative travel 

time difference, , for the source wave to travel the distance increment.  This technique 

has several advantages over selecting time markers within the seismogram (Baziw 
1993, 2002), among others the human bias associated with visually selecting a 
reference point or time marker is minimized. 
 
Normalizing the cross-correlation of the zero mean seismic signals by their standard 
deviations gives the cross-correlation coefficient: 

 

 

(2) 

 
The CCC between the two DST waves is typically used to assess the quality of the 
interval velocity estimate as this parameter gives an indication of the similarity between 
the two waves being correlated.  While on its own the CCC has proven to be an 
unreliable indicator of the overall quality of a seismic trace (since it is highly dependent 
on the digital filter applied to the raw seismic signals), it is still a useful component of 
seismic trace characterization.  As an STC parameter the CCC value is calculated on 
the full waveforms after applying polarization analysis.  
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Parameter 3: SSP 
 
The probability density of a normal (or Gaussian) distribution is given as  
 

 
 

(3) 

where μ denotes the mean or 
expectation of the distribution and σ 
denotes the standard deviation with 
variance σ2. The area under the 
normal pdf curve is unity. Figure 5 
illustrates example of normal pdfs for 
varying μ and σ2 values. All the curves 
in Fig. 1 have the classical bell-shape.  
 
Figure 6 illustrates a Berlage source 
wave (Baziw and Ulrych (2006), Baziw 
and Verbeek (2014)), which is 
commonly used within seismic signal 
processing for simulation purposes.  
The Berlage source wave is 
analytically defined as  
 
          (4) 

 
where H(t) is the Heaviside unit step 
function [H(t) = 0 for t ≤ 0 and H(t) = 1 
for t >0].  The amplitude modulation 
component is controlled by two 
factors: the exponential decay term h 
and the time exponent n.  These 
parameters are considered to be 
nonnegative real constants.  Figure 7 
illustrates the frequency spectrum 
(solid black line) of the Berlage source 
wave shown in Fig. 6 with the normal 
pdf approximation shown as a dotted 
grey line, with  μ = 69 Hz and σ =  
32.5 . As is evident from Figure 7, the 
frequency spectrum of the simulated 
Berlage source  wave closely  
matches that of a bell-shaped curve.  
 
To determine the deviation of the 
source wave frequency spectrum from 
a desirable bell-shaped curve the 
following process is proposed: 

Figure 5: Example of normal pdfs for varying μ and 
σ2 values.  (after, http://www.dplot.com/probability-
scale.htm 

Figure 6: Berlage source wave with of f = 70 Hz, n 
= 2, h = 270  and ϕ = 40º specified. 

Figure 7: Frequency spectrum (solid black line) of 
Berlage source wave illustrated in Fig. 2 with the 
normal pdf approximation shown as a dotted grey 
line. 
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Apply a digital zero-phase shift frequency filter to the entire seismic trace so that high 

frequency measurement noise is removed.  

1. Calculate frequency spectrums for X(t) and Y(t) recordings, SX(f) and SY(f), and 
determine which axis has the dominant frequency response axis (denote as 
S(f)). 

2. Force the area under S(f) to approach unity by uniformly modifying the 
amplitudes within S(f). This step is outlined below by eqs. 5(a) and 5(b).  

 
 

 

 

 
(5a) 

 
(5b) 

 
In eq. 5(a), Δf denotes the frequency increment resolution. 

3. Determine μ (dominant frequency), p(μ) (maximum spectral amplitude), and σ = 
1/( p(μ) √(2π)) utilizing an iterative forward modelling (IFM) technique such as the 
Simplex method (Baziw, 2002, 2011). In this IFM case the cost function to 
minimize is the RMS difference between the normalized area under S(f) and the 
derived area (using eq. (3)) from a normal pdf which utilizes the currently 
estimated μ and  σ values. 

4. Calculate p(f) via equation (1) utilizing the IFM estimates μ and σ from Step 4.  

5. Calculate   

6. Calculate       

7. Calculate parameter R which is defined as R = ε1/ε2  

8. Signal Shape Parameter (SSP) is then calculated as SSP = 1-R.   
 
 

Parameter 4: PSD 
 
The “Peak Symmetry Differential” (PSD) parameter facilitates the identification of traces 
whose peak source wave responses have been significantly skewed due to 
measurement noise or source wave reflection interference.  Fig. 8 illustrates this 
phenomenon.  In Fig. 8(A) we have an ideal source wave recording where no 
interference is present.  In this case the time difference between the two zero crossings 
bounding the peak response (A1) are identical (Δt1 = Δt2).  In Fig. 8(B) we have a source 
wave recording with interference, resulting in skewing or time shifting of the peak source 
wave response.  The “peak symmetry” error assessment is also carried out on the 
adjacent peaks and/or troughs if the amplitude exceeds 70 % of that for the peak 
response 
 
The PSD parameter is determined as follows: 

1. Apply a  frequency filter to the entire seismic trace to eliminate irrelevant zero 
crossings 
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2. Identify the largest peak/trough of the seismic trace and determine the time 
differential from the moment the peak occurs to the zero crossings on either side 
(Δt1 and Δt2 respectively) 

3. Calculate Δt = |Δt1 - Δt2|. 
4. If the amplitude of the adjacent trough/peak on either side exceeds 70 % of that 

for the largest peak/trough response calculate the Δt value for that trough/peak. 
5. Determine the maximum Δt value 
6. The PSD is then:  for Δt ≤ 0.02  PSD = 1 

for 0.02 ≤ Δt ≤ 0.8 PSD = 1.026 – Δt/0.78 
for Δt ≥ 0.8  PSD = 0 

 

 

 

 

Figure 8: Source wave peak distortions due to measurement noise or source wave 
reflection interference. (A) Ideal source wave recording where no interference is 
present. (B) and (C) Source waves with interference resulting in skewing or time 
shifting of the peak 
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Parameter 5: SNR 
 
The initial four parameters (LIN, CCC, SSP and PSD) are derived after filtering (albeit to 
a minimal extent) the seismic traces under analysis.  The last parameter uses as input 
the as-recorded seismic trace and compares it with the filtered trace to assess the extent 
of background noise.  To get a complete assessment it is essential that the recorded 
trace reflects accurately the signals that exist at the sensor location, in other words that 
the sensors display with minimal distortion the background noise and seismic source 
waves (see also BCE Technical Note 10).  In the remainder of this Technical Note it is 
therefore assumed that sensors are used where the sensor output accurately represent 
the sensor input. 
 
Figure 9 illustrates various seismic traces with varying signal-to-noise ratios.  In each 
figure the filtered black traces (200 Hz low pass filter) are superimposed upon the 
corresponding virtually unfiltered seismic red traces (a 700 Hz low pass filter was applied 
to remove electrical noise).  In Fig. 9(A) the unfiltered dominant source wave recording 
closely matches that of the filtered trace, which implies a high signal-to-noise ration.  In 
Figs. 9(B) to (D) the unfiltered traces correlate a lot less with the filtered traces. 
 

  

  

Figure 9. Examples of DST unfiltered (red traces) and corresponding filtered 

(black traces – low pass of 200 Hz applied) seismic time series.  

 
To quantify this aspect the “Signal Noise Ratio” (SNR) parameter is used, which 
revolves around a comparison of the normalized peak response in the original seismic 
trace and that in the filtered trace:  
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The SNR parameter is determined as follows: 
1. Identify the largest peak/trough of the filtered trace and derive an analysis time 

window by moving forward and backward in time (as shown by the solid black 
line in Figure 9(A)). 

2. Normalize both the unfiltered and filtered responses within this time window. 
3. Calculate the difference trace between the normalized and time windowed 

unfiltered and filtered traces. Figure 10 illustrates the difference time series for 
traces illustrated in Fig. 1 and implementing previously outlined Steps 1 and 2. 

4. Calculate the standard deviation σ of the difference trace. 
5. The SNR is then:  for σ ≤ 0.03  SNR = 1 

for 0.03 ≤ σ ≤ 0.7 SNR = 1.045 - σ/0.67  
for σ ≥ 0.7  SNR = 0 

 

  

 
 

Figure 10. Calculated difference time series for traces illustrated in Fig. 9 and the 
SNR values (A) SNR = 0.95, (B) SNR = 0.79, (C) SNR = 0.52 and (D) SNR = 0.24.  
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Appendix 3 – “The use of seismic trace characterization 
to guide the analysis of DST results to obtain more 
accurate soil parameters” (Baziw, E. and Verbeek, G. (2018), 
Proceedings of the 43rd Annual Conference on Deep 
Foundations, 2018, Anaheim, CA, USA, (DFI), article #3137; 
publication #1045 (AM-2018)) 
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The use of seismic trace characterization to guide the 

analysis of DST results to obtain more accurate soil 

parameters 
Erick Baziw 
Baziw Consulting Engineers Ltd., Vancouver, Canada 

Gerald Verbeek 
Baziw Consulting Engineers Ltd., Vancouver, Canada 

 

 
ABSTRACT:   
Downhole Seismic Testing (DST) is a very popular applied seismology site 
characterizing tool within geotechnical engineering.  A challenging aspect of DST is to 
characterize the acquired seismic data sets to determine the analysis method that will 
result in the most accurate interval velocity values.  BCE has invested considerable 
resources into developing Seismic Trace Characterization (STC), which uses various 
independent parameters of the acquired data at a particular depth.  Initial work in this area 
resulted in the selection of the linearity estimate from the polarization analysis, the cross 
correlation coefficient of the full waveforms at the particular depth and the preceding 
depth and a uniquely developed parameter referred to as the signal shape parameter for 
this characterization.  Subsequent analysis in STC identified two other parameters: the 
Signal-Noise-Ratio (SNR) and the Peak Symmetry Differential (PSD).  The paper briefly 
describes these parameters and then outlines how they can guide the data analysis to 
derive more accurate results, especially near surface, which is especially important to 
assess the liquefaction potential in areas prone to earthquakes, such as California.  The 
process will be illustrated with actual data from another area prone to earthquakes, 
namely New Zealand. 

 

1.  INTRODUCTION 

 

The near surface characterization of low strain in-situ shear wave velocities (VS) has 

proven critical for liquefaction assessment.  Liquefaction is a phenomenon in which 

dynamic loading of saturated soil results in the material properties to change suddenly 

from a solid state to a liquefied state.  VS is an important parameter for evaluating 

liquefaction potential due to fact that it is influenced by many of the variables that 

influence liquefaction (e.g., void ratio, soil density, confining stress, stress history, and 

geologic age (Andrus et al., 1997)).  Aki and Richards (2002) also outline that the 

amplitude of ground motion should depend on the density and shear wave velocity of 

near surface soils and rocks according to the theory of wave propagation.  Since the 

change in density with the increase in depth is relative minor compared to that of the 

shear wave velocity, the latter is a very useful parameter to represent site conditions 

(Stewart et al., 1997).  Bray (2014) and his colleagues carried out an extensive 

geotechnical analysis of the catastrophic liquefaction that occurred in Christchurch, New 

Zealand in 2010 and 2011 and found that near surface rather than deep liquefaction 

resulted in extensive foundation damage.  



 
 

SC3-RAV Data Analysis ©Baziw Consulting Engineers Ltd. 48 

 COMMERCIALLY CONFIDENTIAL 

 

Downhole Seismic Testing (DST) has proven to be a very powerful technique for 

measuring in-situ near surface VS values (ASTM, 2017).  The main goal in DST is to 

obtain arrival times as the source wave travels through the soil profile of interest, and 

from these arrival times the velocities are then calculated by taking into account proper 

source wave raypaths (Baziw, 2002; Baziw and Verbeek, 2012 and 2016).  Near surface 

DST seismic data set can be particularly  challenging to process compared to relatively 

deeper acquired traces as they are more effected by near surface measurement noise, “rod 

noise”, near-field source waves, and reflections.  Especially for those traces it is critical 

to have the ability to assess the quality of the DST seismic trace and to get guidance how 

to best analyze these traces. 

BCE has invested considerable resources (Baziw and Verbeek, 2016a, 2016b, and 

2017) into the characterization of acquired DST data sets and the guidance for data 

analysis that can be derived from this characterization.  This paper summarizes that work 

and also describes proposed signal processing and post data analysis techniques for data 

sets with poor trace metrics.  

 

2. THE STC PARAMETERS  

 

The analysis of numerous seismic data sets, many of which were recorded with triaxial 

seismic sensors, has resulted in a better understanding of how a seismic trace can be 

characterized.  Typically, investigators have utilized the Cross-Correlation Coefficient 

(CCC), which gives an indication of the similarity between traces used in obtaining 

relative arrival times (Baziw, 1993), but this parameter has been proven to be an 

unreliable indicator due to the fact that measurement noise (random and systematic) can 

also be correlated and result in high CCC values.  In order to overcome these limitations 

other parameters were added and over the years the number of parameters considered by 

the authors has increased to five. 

 

STC Trace Metric 1: Linearity (LIN) Estimates from the Polarization Analysis 

 

The linearity or rectilinearity values can be obtained from hodograms, i.e. by plotting 

the responses recorded on different axes against one another and then fitting least squares 

best fit lines.  Since hodograms with linearity values nearing 1.0 identify seismic 

recordings that have highly correlated responses and strong directionality, the quality of 

the data set with a high linearity value (such as shown in Figure 1) can be considered 

good.  Hodograms with lower linearity values on the other hand indicate a lower quality 

trace (whether due to poor source generation, near-field waves, ambient noise that is not 

easily filtered out, source wave reflections, or differential probe coupling) 
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STC Trace Metric 2: Cross-Correlation Coefficient (CCC) 

 

The cross-correlation between two time or distance offset seismograms is given as  

 

 
 

(1) 

 

Normalizing the cross-correlation of the zero mean seismic signals by their standard 

deviations gives the cross-correlation coefficient: 

 

 

(2) 

 

The CCC between the two DST seismic traces gives an indication of the similarity 

between the two waves being correlated.  CCC values approaching 1.0 indicate that the 

two waveforms are highly correlated. CCC values approaching 0 indicate very poor 

correlation. 

 

STC Trace Metric 3: Signal Shape Parameter (SSP) 

 

The SSP trace metric quantifies the deviation of the shape of the frequency spectrum 

from an ideal bell shape.  Based upon frequency spectrum analysis of large sets of DST 

data it was determined that the shapes of high quality DST data sets had frequency 

spectrums closely resembling Gaussian bell-shape pdf curves (Baziw and Verbeek, 

2016a), which can be described as follows: 

 
 

(2) 

 

where μ denotes the mean or expectation of the distribution and σ denotes the standard 

deviation with variance σ2.  Based on this observation a STC parameter was developed 

which quantified the deviation of the shape of the frequency spectrum of the seismic trace 

under analysis from a bell-shaped pdf curve.  

Figure 1: (A) DST X and Y axis seismic responses illustrating alignment of peaks and troughs. 

(B) Corresponding hodogram (light grey dots) and linear least squares best fit (dark black 

line) with a calculated linearity of 0.89  
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STC Trace Metric 4: Peak Symmetry Differential (PSD) 

 

 The PSD trace metric facilitates the identification of traces whose peak source wave 

responses have been significantly skewed due to measurement noise or source wave 

reflection interference.  Figure 2 illustrates this phenomenon.  In Fig. 2(A) we have an 

ideal source wave recording where no interference is present.  In this case the time 

difference between the two zero crossings bounding the peak response (A1) are identical 

(Δt1 = Δt2).  In Fig. 2(B) we have a source wave recording with interference, resulting in 

skewing or time shifting of the peak source wave response.  The “peak symmetry” error 

assessment is also carried out on the adjacent peaks and/or troughs if the amplitude 

exceeds 70 % of that for the peak response.  Obviously traces with a lower PSD value are 

of a lesser quality and require more attention during analysis. 

 

  

 
STC Trace Metric 5:  Signal to Noise Ratio (SNR) 

 

The SNR trace metric uses as input the as-recorded seismic trace and compares it 

with the filtered trace to quantify what portion of the spectral content of the recorded 

seismogram resides within the desired source frequency spectrum.  While this parameter 

provides mainly insight in the quality of the data acquisition (such as gain settings, noise 

levels and testing environment) and does not really provide guidance for data analysis, it 

is nevertheless an important parameter.  When during testing to establish SH interval 

velocities testing is performed from two sides, the SNR metric is very beneficial in 

selecting the outcome when there is a large spread between the two results. 

It should be noted that it is possible for source wave distortions (such as near-field 

effects, reflections, refractions, and “dirty sources”) to have spectral content which 

resides within the source wave frequency spectrum.  Consequently the parameter value 

may imply a better quality trace than it really is. 

3.0 RECOMMENDED DATA ANALYSIS and SIGNAL PROCESSING BASED on 

STC 

Figure 2. Source wave peak distortions due to measurement noise or source wave 

reflection interference. (A) Ideal source wave recording where no interference is present. 

(B) Source wave with interference resulting in skewing or time shifting of the peak source 

wave response. The black line is the unfiltered trace while the red line is the filtered trace 

where a low pass filter of 200 Hz was applied.    
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All STC trace metrics vary from 0 to 1 where it is desired that they approach the 

optimal 1.0 value.  Low LIN values are typically handled separately from SSP, CCC and 

PSD values.  This is due to the fact that the LIN values directs the investigator on 

whether the full waveforms should be utilized for analysis or a preferential axis response, 

while the SSP, CCC and PSD trace metrics give indications of the quality of the seismic 

traces under analysis.  Different seismic signal processing techniques are then applied 

based upon the SSP, CCC and PSD values.  

 

3.1 Post Analysis and Signal Processing: Linearity Values 

 

LIN estimates are derived from triaxial or biaxial seismic sensor configurations.  For 

data analyses to obtain horizontally polarized shear wave (VSH) velocity values the X- 

and Y-axis responses are of interest.  LIN values for these responses approaching 1.0 are 

highly desirable and indicate that there is a preferred directionality of the source wave 

responses, and therefore the X- and Y-axis responses can be rotated on to the full wave 

form axis, which increases the signal-to-noise ratio.  Generally, LIN values 0.8 or better 

indicate that the full waveforms can be utilized without any cause of concern, while 

lower values require corrective action as illustrated in the four test cases below. 

 

3.1.1 Test Case LIN 1 – overall linearity values ≥ 0.8 with a few outliers due to poorly 

correlated source wave responses. 

 

DST Data sets with these LIN values are typically of very good quality and the full 

wave forms can be used for data analysis.  Generally, there are either dominant responses 

on the X axis and/or Y axis or highly correlated responses on the X and Y axis, but a few 

lower LIN values may need to be addressed.  Figure 3 illustrates filtered (200Hz low 

pass) Vertical Seismic Profile (VSP).  The filtered VSP illustrates X- and Y-axis 

responses with the dominant source wave responses on the Y axis.  The corresponding 

LIN values are given in Table 1 and for most depths they exceed 0.8, in which case the 

full wave forms are utilized.  However, lower LIN values occur at depths 1m, 2m and 

9m. 
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 To overcome this the first step is to identify which 

axis shows the dominant response.  If this is consistent 

with the full wave forms then the response on this axis 

can be used in the analysis.  For example, the filtered 

VSP in Figure 3 clearly showed that the dominant 

responses reside on the Y axis.  The filtered traces 

recorded at 1m are shown in Figure 4 and it is clear that 

the responses are not correlated (resulting in the low 

linearity value of 0.52 as shown in Table 1).  It is also 

clear that there is a high quality Y-axis response 

recorded at this depth, which is in line with the dominant 

responses at the other depths. Therefore at 1 m the Y-axis 

response is utilized rather than the full wave form. This is also the case for the traces 

recorded at 2m and 9m which had associated low linearity values of 0.55 and 0.58, 

respectively.  

 

3.1.2 Test Case LIN 2 – overall linearity values ≥ 0.8 with a few outliers due to low SNR 

 

Data sets with these LIN values are typically of very good quality and the full wave 

forms can be used for post analysis.  Generally, there are either dominant responses on 

the X axis and/or Y axis or highly correlated responses on the X and Y axis, but a few 

lower LIN values may need to be addressed.  Figure 5 illustrates filtered (200Hz low 

pass) Vertical Seismic Profile (VSP) for test case LIN2.  The filtered VSP in Figure 5 

illustrates X and Y axis responses where there is no single axis that contains the dominant 

response at all depths.  The corresponding and widely varying LIN values are given in 

Table 2. 

Depth [m] Linearity [0-1]  

1 0.52 

2 0.55 

3 0.83 

4 0.80 

5 0.86 

6 0.85 

7 0.82 

8 0.86 

9 0.58 

10 0.82 

Figure 3. Filtered (200 Hz low pass) VSP [LIN 1] 

 

Table 1. Linearity Values for [LIN 1] 

Figure 4. Filtered recorded 

traces at 1 m [LIN 1]  
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Figure 6 illustrates the X- and Y-axis responses recorded at 10m, which demonstrates that 

the high linearity is due to correlated X and Y axis responses and not due to dominant 

responses on either the X or Y axis.  This in turn means that the X and Y axis responses 

can be utilized in post analysis where poor linearity values occur due to noise responses 

and not poorly correlated source wave responses.  Figure 7 illustrates the filtered X- and 

Y-axis responses at 2 m, where again the peaks and troughs of the source wave responses 

align, but the interference on the X axis (highlighted by the red circle) introduces such 

distortion on the X axis so that the LIN value is significantly reduced.  For this case we 

can utilize the higher quality Y-axis response along with the full wave forms for other 

depths.   

 

Depth [m] Linearity [0-1]  

2 0.58 

3 0.70 

4 0.84 

5 0.62 

6 0.30 

7 0.80 

8 0.81 

9 0.48 

10 0.81 

Table 2. Linearity Values for [LIN2] 

 

Figure 5. Filtered (200 Hz low pass) VSP [LIN 2] 

 

Figure 6. Recorded traces at 10 m [LIN 2] Figure 7. Recorded traces at 2 m [LIN 2] 
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3.1.3 Test Case LIN 3 – Overall low linearity values with poorly correlated X and Y axis 

responses, but with a dominant response at all depths on the same axis 

 

For data sets with low LIN values we cannot utilize both X and Y axis responses in 

post analysis.  The investigator must then select either the X or Y axis responses for data 

analysis and subsequently determine individual axis trace metrics values.  Figure 8 

illustrates filtered (200Hz low pass) Vertical Seismic Profile (VSP) for test case LIN3, 

where the Y-axis responses are clearly dominant and of higher quality.  The 

corresponding LIN values are given in Table 3, suggesting very poorly correlated X- and 

Y-axis responses.  In cases like this the investigator proceeds with the analysis using the 

higher quality responses, which in this case are obviously the Y axis responses. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3.1.4 Test Case LIN 4 – Overall low linearity values with poorly correlated X and Y axis 

responses and no dominant response on the same axis for all depths. 

 

As mentioned before, for data sets with low LIN values the post-analysis cannot 

utilize X and Y axis responses randomly: the investigator must select either the X or the 

Y axis responses.  But sometimes this is impossible and the X-axis responses have to be 

used for certain depth intervals and the Y-axis responses for others.  In that case it is 

important that there is overlap when transitioning from X axis to Y axis responses and 

vice versa.  For example, assume the investigator is going to use X axis responses for 

depths 1m to 6m and Y axis responses from 6m to 15m.  In this case interval arrival times 

are obtained for traces between 1m and 6m utilizing the X-axis responses and a reference 

time for one of the depths between 1m to 6m.  Next the Y axis responses for traces 

between 6m to 15m are utilized to obtain interval arrival times with the X axis arrival 

time for 6m as the reference time.  The arrival time are then feed into an algorithm which 

takes into account raypath refraction when estimating interval velocities (Baziw, 2002; 

Baziw and Verbeek, 2012 and 2014).  

Depth [m] Linearity [0-1]  

11 0.76 

12 0.80 

13 0.72 

14 0.69 

15 0.65 

16 0.61 

17 0.57 

18 0.67 

19 0.75 

20 0.67 

Figure 8. Filtered (200 Hz low pass) VSP [LIN 3] 

 

Table 3. Linearity Values for [LIN3] 
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Figure 10. Filtered VSP after batch 

signal decay [SSP PSD CCC 1] 

 

3.2 Post Analysis and Signal Processing: CCC, SSP, and PSD Values 

 

While the LIN value helps with the selection of the traces to be analyzed, the SSP, 

CCC and PSD trace metrics give indications of the quality of the seismic traces under 

analysis based upon the form and shape of the time series and corresponding spectral 

content.  Several different combinations (high vs low) of SSP, PSD and CCC values can 

exist due to the fact that they address different characteristics of the acquired seismic 

trace.  Based on the values of these parameters the most appropriate processing technique 

(batch signal decay, seismic feature decay and aggressive frequency filtering) is then 

selected as illustrated in the various test cases below, which assume threshold values for 

SSP, PSD and CCC of 0.6, 0.8 and 0.3, respectively. 

 

3.2.1 Test Case  SSP PSD CCC 1 – Good CCC and PSD values, but poor SSP values 

 

Data sets with good CCC and PSD values but poor SSP values occur whenever there 

is source wave “ringing” as illustrated in the filtered (200 Hz low pass filter) VSP in 

Figure 9. Table 4 outlines the corresponding SSP, CCC, and PSD trace metric. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Clearly only the SSP values are cause of concern and this 

is readily addressed through batch signal decay (BSD), 

which applies a time window around the peak responses 

moving forward and backward in time by two crossovers. 

The implementation of BSD on this data set is shown in 

Figure 10. 

 

 

 

 

Depth [m] SSP [0-1] CCC [0-1] PSD [0-1] 

20 0.547 0.9216 0.96 

21 0.525 0.8266 0.48 

22 0.379 0.8024 0.87 

23 0.483 0.9151 0.65 

24 0.556 0.9533 0.71 

25 0.491 0.9671 0.79 

26 0.51 0.9587 0.73 

27 0.391 0.9379 0.96 

28 0.428 0.9144 0.84 

29 0.544 0.8841 0.61 

30 0.363 0.8569 0.94 

Figure 9. Filtered VSP [SSP PSD 

CCC 1] 

 

Table 4. SSP, CCC and PSD Values for 

[SSP PSD CCC 1] 

 



 
 

SC3-RAV Data Analysis ©Baziw Consulting Engineers Ltd. 56 

 COMMERCIALLY CONFIDENTIAL 

 

Figure 11. Filtered VSP with peak skewing 

areas highlighted [SSP PSD CCC 2] 

 

Figure 12. DST seismic traces between 12 m 

and 14 m [SSP PSD CCC 2] illustrating 

first trough responses.  

 

Figure 13. Filtered VSP after signal feature 

decay [SSP PSD CCC 2]  

 

3.2.2 Test Case  SSP PSD CCC 2 – Good CCC values, but poor PSD and SSP values 

 

Data sets with very low PSD values generally are affected by extensive source peak 

skewing. This is illustrated in the filtered (200Hz low pass) VSP in Figure 11, while the 

trace metrics values of SSP, CCC and PSD are given in Table 5 with low PSD values 

between 10m and 13 m and also between 17 m and 20 m.  The black circles outline in 

Fig. 11 outline the extensive peak skewing.  To address the low PSD values a consistent 

portion of the seismic source wave signature where there is minimal to no skewing is 

isolated throughout the profile (so-called Signal Feature Decay (SFD)).  The seismic 

traces recorded between 12 m and 14 m shown in Fig. 12 clearly show that there is 

minimal first trough distortion, and therefore SDF is applied on this data set to isolate the 

first troughs.  The results are illustrated in Figure 13.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Depth [m] SSP [0-1] CCC [0-1] PSD [0-1] 

10 0.49 0.9603 0.01 

11 0.45 0.9239 0.01 

12 0.39 0.9323 0.01 

13 0.55 0.9144 0.01 

14 0.47 0.8582 0.39 

15 0.58 0.9283 0.96 

16 0.53 0.9553 0.84 

17 0.52 0.952 0.01 

18 0.59 0.9884 0.01 

19 0.56 0.9464 0.01 

20 0.54 0.9814 0.01 

Table 5. SSP, CCC and PSD Values for 

[SSP PSD CCC 2] 
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3.2.3 Test Case SSP PSD CCC 3 – Good SSP and PSD values, but poor CCC values 

 

If only the CCC values are low, SFD is again the suggested remedial action.  In Fig. 

14 a filtered (200Hz low pass) VSP is shown with the corresponding SSP, CCC and PSD 

trace metrics outlined in Table 6, which shows low CCC values between 3 m and 5 m 

with very good  PSD values and SSP values very close to the desired 0.6 threshold except 

at a depth of 5 m.  The dashed line in Fig. 14 clearly identifies the first trough responses 

in the entire VSP and Figure 15 then shows the VSP after isolating the first trough 

responses by SDF. 

  
Figure 14. Filtered VSP with the first 

trough trend line [SSP PSD CCC 3]. 

 

Figure 15. Filtered VSP after SDF 

applied [SSP PSD CCC 3] 

 

Table 6. SSP, CCC and PSD Values for 

[SSP PSD CCC 3] 

Table 7. SSP, CCC and PSD Values for SSP 

PSD CCC 4 
 

Depth [m] SSP [0-1] CCC [0-1] PSD [0-1] 

2 0.60 N/A 0.54 

3 0.64 0.6497 0.69 

4 0.59 0.5229 0.73 

5 0.48 0.6394 0.75 

6 0.46 0.8639 0.78 

8 0.50 0.6862 0.85 

9  0.59 0.8853 0.87 

10 0.59 0.8558 0.83 

 

Depth [m] SSP [0-1] CCC [0-1] PSD [0-1] 

1 0.563 N/A 0.67 

2 0.462 0.7526 0.07 

3 0.45 0.6931 0.01 

4 0.517 0.7264 0.37 

5 0.75 0.833 0.99 

6 0.6 0.9513 0.09 

 

3.2.4 Test Case SSP PSD CCC 4 – Poor SSP, PSD and CCC values 

 

In certain cases the entire VSP shows evidence of interference, resulting in poor SSP, 

PSD and CCC values.  To address this type of data set an aggressive 120Hz low pass 

filter is applied so that the source wave interference is “smoothed”.  The “smoothed” 

responses then have SFD applied.  This is illustrated on the filtered (200Hz low pass) 

VSP shown in Fig. 16, where there is evidence of significant source wave distortions 

throughout the source wave responses.  Table 7 outlines the corresponding SSP, CCC and 
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Figure 16. Filtered VSP with the evidence of 

interference at all depths [SSP PSD CCC 4] 

 

Figure 17. Aggressively filtered VSP 

after SDF [SSP PSD CCC 4] 

 

PSD trace metrics, while Figure 17 shows the data set after applying an aggressive 120Hz 

low pass filter and SDF on the “smoothed” second peak responses.   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3.3 Post Analysis and Signal Processing: SNR Values 

 

When based on the LIN values the traces to be analyzed are selected, and based on 

the PSD, SSP and CCC values the most appropriate processing technique is determined, 

the SNR value can provide inside when there is a substantial difference between the 

outcome for the signals from the right side and the left side.  

In Table 8 below the calculated interval velocities are shown for the right side and the 

left side, which reflect a larger spread (defined as ½ x (LS Velocity – RS )/Avg. 

Velocity) than desired (the objective is to have the spread within 10 %).  Given the SNR 

values it can be concluded that the results for the right side are most likely more reliable, 

given the higher quality seismic traces at that side. 

 

Table 8. RS and LS SNR and Interval Velocity Values 
Depth 

 [m] 

SNR RS 

 [0-1] 

SNR LS 

 [0-1] 

RS Velocity 

 [m/s]  

RS Velocity  

[m/s] 

Percent Difference  

(%) 

2.000 0.95 0.74 N/A N/A  

2.500 0.89 0.57 290 230 11.5 

3.000 0.87 0.64 265 200 14 
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Figure 18. Unfiltered (black trace) 

superimposed upon filtered trace (light 

grey) for RS recorded at 2.5m.  

 

Figure 19. Unfiltered (black trace) 

superimposed upon filtered trace (light 

grey) for LS recorded at 2.5m.  

 

 

CONCLUSIONS 

 

Downhole seismic testing (DST) is a very popular applied seismology site 

characterizing tool within geotechnical engineering.  One of the fundamental goals of 

DST is to quantify the shear wave interval velocities (VS ) as this is an important 

parameter for evaluating the liquefaction potential due to fact that it is influenced by 

many of the variables that influence liquefaction.  This paper has outlined BCE’s newly 

Seismic Trace Characterization (STC), which is based on various independent seismic 

trace metrics of the acquired DST data at a particular depth.  There are currently five 

independent trace metrics which are linearity, cross correlation coefficient, signal shape 

parameter, peak symmetry differential and signal-to-noise ratio. This paper also outlined 

how these 5 parameters can guide the data analysis to derive more accurate results. 
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Appendix 4 – “Analytically modelling DST arrival time 
databases with high order polynomials for optimal high 
resolution imaging" to be presented and published in 
the DFI 47th Annual Conference on Deep Foundations 
conference proceedings. October 4–7, 2022 – National 
Harbor, Maryland 

 

Note: The above paper will be included in this training manual once it has been presented 

and published in the 2022 DFI conference proceedings. Technical Note 33 is included at 

this time for reference. 
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Fitting higher order polynomials to DST arrival time 
data sets for high resolution imaging 

 

Introduction 

 

BCE has developed a new DST analysis technique which “best fits” a high order 

polynomial to  arrival time data sets. In this current mathematical design a Kalman filter 

formulation is utilized to estimate the coefficients of polynomials which “best fit” DST 

arrival time data sets. The best fit polynomial arrivals are then feed into BCE’s FMDSM 

technique. This technique has the following highly desirable features: 

 

1. Ability to utilize all arrival time estimates irrespective of measurement errors. 

2. Ability to process small depth interval (≤ 0.5m) arrival time data sets. 

3. Polynomial “best fit” function allows for user specification of desired depth 

intervals for data interpolation. 

4. Facilitates sophisticated data fusion for significantly more accurate DST interval 

velocity estimation. 

5. RMS, MAPE, R2, and R2C accuracy parameters facilitate selecting the appropriate 

polynomial order and quantify the accuracy of the “best fit” polynomial. 

 

Implementation of this technique on both DST onshore and offshore arrival times has 

resulted in very impressive results. It is the intention of BCE to expand this analytical 

technique to tomographic modelling and absorption estimation. 
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Figure 1.  Left Side (LS), Right Side (RS), and averaged arrival times.  

On Shore DST Example: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Figure 2.  8th order polynomial best fit estimate to averaged results of Fig. 1.  
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BEST FIT 8th ORDER S WAVE – 0.5m DEPTH INCREMENT 

Depth 
[m] 

 Arrival Time 
[ms] 

Interval FMDSM Velocity 
[m/s] 

   

1 5.1198 336 

1.5 7.589288 181 

2 10.18546 177.5 

2.5 12.72785 183.1 

3 15.17359 191.7 

3.5 17.58675 196 

4 20.08186 191.7 

4.5 22.78291 179.1 

5 25.79552 162 

5.5 29.19001 144.7 

6 32.9933 129.7 

6.5 37.18784 118 

7 41.71574 109.6 

7.5 46.48668 104.2 

8 51.38802 101.5 

8.5 56.29613 101.5 

9 61.08768 104 

9.5 65.65014 109.3 

10 69.89065 117.5 

10.5 73.74286 129.3 

11 77.17118 145.2 

11.5 80.1724 165.6 

12 82.77439 190.6 

12.5 85.03231 219.2 

13 87.02226 248.2 

13.5 88.83311 272.5 

14 90.55693 286.2 

14.5 92.27886 286.8 

15 94.06745 276.5 

15.5 95.96638 260.9 

16 97.98908 245.3 

16.5 100.1174 233.4 

17 102.3065 227.2 

17.5 104.4965 227.3 

18 106.635 232.9 

18.5 108.7099 240 

19 110.797 238.5 

19.5 113.1239 213.7 

20 116.1525 164 
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Best Fit Polynomial FMDSM results 0.5m Depth Increments 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 
Figure 3.  “Best fit” polynomial FMDSM profile.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Figure 4.  “Best fit” polynomial interval velocity plot.  
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Off Shore DST Example 1: 

 

Four sets of SH source waves acquired (left side top and bottom sensors (LS TS and LS 

BS, respectively) and right side top and bottom sensors (RS TS and RS BS, respectively).  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

Figure 5.  Left Side (LS TS and LS BS), Right Side (RS TS and BS), and averaged arrival times.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Figure 6.  7th order polynomial best fit estimate to averaged results of Fig. 5.  
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BEST FIT 7th ORDER S WAVE – 0.5m DEPTH INCREMENT 

Depth 
[m] 

 Arrival Time 
[ms] 

Interval FMDSM Velocity 
[m/s] 

   

1.24 61.7406 89.7 

1.74 60.65947 99.6 

2.24 60.13957 108 

2.74 60.07694 116.5 

3.24 60.40377 125 

3.74 61.06047 133.1 

4.24 61.99495 140.6 

4.74 63.16193 147.3 

5.24 64.52227 153.3 

5.74 66.04235 158.7 

6.24 67.69348 163.4 

6.74 69.45141 167.8 

7.24 71.29577 171.7 

7.74 73.20963 175.4 

8.24 75.17906 178.8 

8.74 77.19274 181.9 

9.24 79.24159 184.8 

9.74 81.31842 187.6 

10.24 83.41764 190.1 

10.74 85.53499 192.4 

11.24 87.66726 194.6 

11.74 89.81209 196.6 

12.24 91.96777 198.4 

12.74 94.13304 200 

13.24 96.30699 201.4 

13.74 98.48888 202.7 

14.24 100.6781 203.8 

14.74 102.8738 204.9 

15.24 105.0754 205.8 

15.74 107.282 206.7 

16.24 109.4924 207.6 

16.74 111.7054 208.4 

17.24 113.9195 209.3 

17.74 116.1329 210.3 

18.24 118.3437 211.4 

18.74 120.5497 212.6 

19.24 122.7488 214 

19.74 124.9384 215.5 

20.24 127.1161 217.2 

20.74 129.2793 219.2 

21.24 131.4256 221.4 

21.74 133.5525 223.8 

22.24 135.6577 226.5 

22.74 137.739 229.4 

23.24 139.7947 232.6 

23.74 141.823 236 

24.24 143.8227 239.7 

24.74 145.7931 243.5 

25.24 147.7336 247.4 

25.74 149.6442 251.5 

26.24 151.5255 255.7 
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Figure 7.  “Best fit” polynomial FMDSM profile.  

 

 

26.74 153.3785 259.8 

27.24 155.2047 263.8 

27.74 157.0061 267.7 

28.24 158.7853 271.2 

28.74 160.5451 274.5 

29.24 162.289 277.2 

29.74 164.0207 279.5 

30.24 165.744 281.1 

30.74 167.4632 282.1 

31.24 169.1824 282.4 

31.74 170.9057 282.1 

32.24 172.6368 281.1 

32.74 174.3791 279.7 

33.24 176.1353 277.8 

33.74 177.9073 275.6 

34.24 179.6956 273.4 

34.74 181.4996 271.3 

35.24 183.3165 269.6 

35.74 185.1418 268.6 

36.24 186.9684 268.6 

36.74 188.786 270.1 

37.24 190.5813 273.6 

37.74 192.337 279.8 

38.24 194.0314 289.9 

38.74 195.638 305.5 

39.24 197.1248 329.7 

39.74 198.4534 368 

40.24 199.5789 432.3 

40.74 200.4486 553.5 

41.24 201.0016 843.4 
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Figure 8.  “Best fit” polynomial interval velocity plot. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Figure 9.  “Best fit” polynomial interval velocity plot (41.24m dropped) . 
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Off Shore DST Example 2: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Figure 10.  Left Side (LS TS and LS BS), Right Side (RS TS and BS), and averaged arrival times.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Figure 11.  7th order polynomial best fit estimate to averaged results of Fig. 5.  
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BEST FIT 7th ORDER S WAVE – 1m DEPTH INCREMENT 

Depth 
[m] 

 Arrival Time 
[ms] 

Interval FMDSM Velocity 
[m/s] 

   

0.41 93.77395 50.6 

1.41 85.90899 58.8 

2.41 81.12878 74.6 

3.41 78.58437 99.3 

4.41 77.68655 133.3 

5.41 77.98234 174.5 

6.41 79.13037 215.5 

7.41 80.87925 245.9 

8.41 83.04863 260.3 

9.41 85.51293 263.7 

10.41 88.18739 263 

11.41 91.01646 262.3 

12.41 93.96423 263.3 

13.41 97.00677 266.5 

14.41 100.1263 272 

15.41 103.3067 279.5 

16.41 106.5308 288.9 

17.41 109.7786 299.9 

18.41 113.0267 312 

19.41 116.2487 325.1 

20.41 119.4159 338.6 

21.41 122.4994 352 

22.41 125.4718 364.8 

23.41 128.3095 376.4 

24.41 130.9951 386.3 

25.41 133.5193 394 

26.41 135.8833 399.2 

27.41 138.0999 401.8 

28.41 140.1946 401.8 

29.41 142.2055 399.4 

30.41 144.1824 395 

31.41 146.1853 388.8 

32.41 148.2804 381.6 

33.41 150.5362 373.5 

34.41 153.0165 365 

35.41 155.7724 356.5 

36.41 158.8327 348.3 

37.41 162.191 340.5 

38.41 165.7918 333.3 

39.41 169.5129 327 

40.41 173.1466 321.4 

41.41 176.3765 316.8 

42.41 178.3231 313 

43.41 181.5233 310.2 

44.41 184.7442 308.4 

45.41 187.9763 307.4 

46.41 191.2096 307.4 

47.41 194.4348 308.3 

48.41 197.6429 310 

49.41 200.8257 312.5 

50.41 203.9757 315.8 
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FMDSM results 1m Depth Increments 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 12.  “Best fit” polynomial FMDSM profile.  

51.41 207.0869 319.8 

52.41 210.1542 324.4 

53.41 213.1741 329.5 

54.41 216.1443 335.1 

55.41 219.0641 340.9 

56.41 221.9343 346.8 

57.41 224.7567 352.7 

58.41 227.5347 358.3 

59.41 230.2725 363.6 

60.41 232.9751 368.3 

61.41 235.6476 372.5 

62.41 238.2954 376 

63.41 240.9231 378.9 

64.41 243.5342 381.4 

65.41 246.1301 383.7 

66.41 248.7099 386.1 

67.41 251.2687 389.3 

68.41 253.7971 394 

69.41 256.2802 401.3 

70.41 258.6958 412.5 
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Figure 13.  “Best fit” polynomial interval velocity plot. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Figure 14.  “Best fit” polynomial FMDSM profile (0.5m depth increment).  
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Figure 15.  “Best fit” polynomial interval velocity plot (0.5m depth increment). 
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Off Shore DST Example 3: 
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BEST FIT 5th ORDER S WAVE – 0.25m DEPTH INCREMENT 

Depth 
[m] 

 Arrival Time 
[ms] 

Interval FMDSM Velocity 
[m/s] 

   

0.43 16.12815 208.2 

0.68 15.81966 221.4 

0.93 15.84154 227.4 

1.18 16.0963 226.1 

1.43 16.51827 220.2 

1.68 17.05338 215.5 

1.93 17.65814 213.5 

2.18 18.29866 214.5 

2.43 18.94968 218.4 

2.68 19.59355 224.8 

2.93 20.21926 233.2 

3.18 20.82146 243.5 

3.43 21.39945 255.1 

3.68 21.95619 267.5 

3.93 22.49736 279.9 

4.18 23.0303 291.6 

4.43 23.56308 301.5 

4.68 24.10347 309.1 

4.93 24.65798 314 

5.18 25.23087 316.4 

5.43 25.82314 317.3 

5.68 26.43157 318.1 

5.93 27.04769 321.1 

6.18 27.65685 328.8 

6.43 28.23719 345.2 

6.68 28.75865 377 

6.93 29.18201 438.9 
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